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Cell Contents 
However simple or complex the spreadsheet, its cells will contain 
one of three possibilities: 

 • l Label     Some form of text 
 • v Value     Number, with formatting 
 • b Blank    Empty cell

 Review the cells in this example spreadsheet: 

The cells are displayed with their associated formatting applied. 
For example, the numbers in cells A3:B6 are displayed as dates. 

To see the actual contents of the cells:

l1 Press Ctrl + ` (the grave accent 
key) or select the Formulas tab 
and click Show Formulas 

The actual contents of the cells, as entered, are displayed: 

To check the type of cell 
content, you use the 
CELL function – e.g. to 
get the type of cell C3: 
 =CELL(“type”,C3)

This shows the cell 
contents as entered. 
For a date, the entered 
value is converted to the 
number of days since 
January 1st, 1900. 
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Numbers in the cells are displayed according to the cell format 
that has been assigned. The same value can appear in many 
different ways – for example: 

...cont’d

The number 100 takes on significantly different appearances, 
depending on the format applied. However, when the cell contents 
are referenced, the same underlying value is assigned, irrespective 
of the format. 

l1 Press Ctrl + ` , or select the Formulas tab and click Show 
Formulas to show the actual contents

The value 100 in cell 
B1 is copied to cells B2 
to B7, and a different 
numeric format is 
applied to each cell. 

Cells C1 to C7 have 
no numeric format 
applied, so take up the 
General format, with the 
value of the cell that is 
referenced. 

Cells C1 to C7 are assigned the contents of cells B1 to B7 
respectively, and in each case the value of 100 is applied, whatever 
the display format may be. 

Whenever a cell is referenced, it is the intrinsic value of the cell 
that will be made use of. 
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Values 

The array identified 
in cell C5 is actually 
incorporated as a 
literal value in the TYPE 
statement. 

These formulas contain 
references to a cell/cells 
(or they could contain 
literal values), and the 
values are processed by 
the operators that are 
included in the formula.

You can use the TYPE function to check the contents of cells. 
This can identify five possibilities: 

 • l Number 
 • 2 Text 
 • 4 Logical  (True or False)  
 • 16 Error notification 
 • 64 Array  

For example: 

Cells such as B4 in the above spreadsheet, or C7 in the first 
example on page 9, are formulas, identified by the initial = (equals 
sign).

Neither the CELL function nor the TYPE function will identify 
a formula as such, but will merely reflect the actual value that the 
formula produces. 

Here are some example formulas: 

Here CELL identifies value and label contents, while TYPE 
identifies number, text, logical and error contents. If the results of 
a formula change, the type identified will change to match. 
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Formulas
Formulas in Excel can be very simple or very complex, but they all 
have the same basic features: 

 • An initial e sign 
  (Tells Excel that a formula follows.) 
 • One or more operands  
  (Values or cell references.)  
 • One or more operators 
  (Symbols indicating how operands are treated.) 
 
The Annual Budget spreadsheet includes some typical formulas: 

Functions are predefined 
formulas, designed to 
carry out tasks that are 
frequently required, and 
to assist in the provision 
of the necessary 
data. In the following 
chapters, we explore the 
categories of functions 
and review examples of 
their use. 

l1 Display the cell contents to see the actual formulas 

Cells C3 to E3 replicate the adjacent cell. Cells B4 to E4 
are percentages of cells B3 to E3. Cells F3 to F5 contain the 
combined values of the adjacent four cells. Cells B8 to E8 contain 
the combined values of the five cells above, calculated using the 
SUM function rather than just adding the specific cells. 

The cell references 
can be individual cell 
addresses, ranges of 
cells, or named ranges.
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Operators used in Excel formulas fall into four groups: 

 • Arithmetic 

• Comparison 

• Text  

• Reference 

The operators available, their descriptions and examples of usage:

Each of the Comparison operators gives a Logical result, which 
can be either TRUE or FALSE. 

The Reference operators allow you to select cells from one or two 
ranges. These cells can then be processed by other operators or 
functions – for example, to calculate the totals of all the selected 
cells. Intersection selects the cells that are common to two ranges – 
for example, the overlap. Union selects all the cells from both ranges. 

Operators

The actions that 
operators perform can 
be applied to literal 
values, referenced 
cells or to the values 
produced by functions. 

Here is the Intersection 
of two ranges: 

This shows the Union of 
two ranges: 
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Order of Calculation
If there are several operands and operators in a formula, the 
sequence in which the calculations are performed can be crucial. 
For example, the formula 4+8^2 could be evaluated from left to 
right, as 12^2, giving 144. Alternatively, the exponential could be 
computed first, as 4+64, giving 68. 

To avoid any ambiguity, Excel uses a predefined sequence. This 
operator precedence is as follows:

This sequence is 
known as PEDMAS 
(parentheses, 
exponential, division, 
multiplication, addition, 
subtraction). In Europe 
it is known as BODMAS 
(brackets, order, division, 
multiplication, addition, 
subtraction). 

You can add parentheses 
and spaces to formulas, 
even if they are not 
strictly necessary, to 
make them easier to 
understand.

Operators such as * and / that are at the same level could be 
evaluated in any order. However, Excel chooses to evaluate them 
from left to right. 

You can use parentheses to control the computation. Expressions 
within the innermost set of parentheses will be calculated first, 
then Excel works outwards. 

To illustrate the effects of parentheses, the same formula is shown 
with various combinations of parentheses: 

The Negation operation 
is treated differently 
in Excel. Arithmetically 
the formula -4̂ 2 is 
-16. However, in Excel, 
Negation is applied 
before Exponential so 
the formula becomes 
(-4)̂ 2, which is 16. 
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Creating Formulas 
You can use a combination of 
typing and selecting to create 
formulas using the various 
operators. 

To add a formula to the example 
Expenses spreadsheet, to calculate 
the full cost of an item: 

l1 Double-click cell C3 to 
select that cell for editing  
 

l2 Type = and then click the 
cell B3 (or simply type B3)  
 
 
 
 

l3 Type *(1+ and then select 
or type B7 (the Taxrate)

Since Taxrate is a singular value, 
you’ll want to make this an 
absolute reference, so that you can 
easily move or copy formulas that 
use this value.  
 

l4 Highlight the cell reference 
C7 and press F4 once 
to switch to absolute 
addressing 

You can also Press F2, or 
click in the Formula bar, 
to switch to Edit mode 
and begin typing the 
formula. 

Pressing F4 repeatedly 
will cycle the highlighted 
cell reference 
between absolute, 
mixed and relative 
cell references.
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...cont’d

You can also Copy the 
cell with the formula, 
then select the target 
cells and use Paste to 
replicate the formula. 

Since the Taxrate is 
an absolute reference, 
it will be replicated 
unchanged, while the 
other cell reference will 
be incremented. 

l5 Type the closing 
parenthesis and press 
Enter to complete the 
formula  
 
 
 
 

You can copy this formula to 
calculate the full cost of other 
items, using the fill handle.  

l1 Select C3, the cell with the 
formula, and click the fill 
handle on the lower right-
hand corner  

l2 Drag down to replicate 
the formula in the next 
two cells, C4 and C5, then 
release the mouse 
 
 

l3 Select cell C6 and enter 
the formula =C3+C4+C5 
typing or selecting the 
required cells, as preferred  

l4 Press Enter to complete 
the formula 
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Named References
When you have absolute references in your formulas, you can name 
them to make their purposes clearer. 

To create a name for a particular cell: 

l1 Select the cell you want to 
name – B7, for example 

l2 Click the Name box, on the 
left of the Formula bar, then 
type the name – for example, 
Taxrate, then press Enter 

l3 Click the Formulas tab and 
select Name Manager in the 
Defined Names group to view 
all the names in the workbook

Names create absolute references to cells or ranges of cells. They 
can be used in formulas and, when these formulas are copied, the 
references will not be changed. 

Names must start with a 
letter, an underscore or 
a backslash. The names 
can contain letters, 
numbers, periods and 
underscores, but no 
spaces. Case is ignored, 
and names can be up to 
256 characters. 

The Name Manager 
shows Defined Names 
for cells, ranges of cells, 
constants (see page 17) 
and tables. 

Using meaningful names 
to reference data items 
may make the intent 
of the formula easier 
to understand, as in 
this example showing 
expenses with sales tax 
and gratuities added. 
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You can name a constant value directly, without having to allocate 
it to a specific cell. For example, if your formulas require a constant 
Discount rate, you can assign a name and a value as follows: 

l1 Select Define Name from the 
Defined Names group on the 
Formulas tab 

l2 The New Name dialog box is 
displayed 

l3 Select the Name box and 
type the constant name – e.g. 
Discount 

l4 Set the Scope – Workbook or 
Sheet – and add a description 
in the Comment box, if desired

l5 Select the Refers to box and 
replace the cell reference with 
the required value (e.g. =0.15) 
and click OK 

You can now use the defined name in your formulas. Note that 
the full name and description will be displayed as you start typing 
the defined constant name. Double-click to enter the name. 

You could type a 
frequently required 
calculation as a formula 
in the Refers to box, 
and then use the defined 
name in other formulas, 
without having to 
assign a cell to hold that 
calculation. 

The constants you 
name can be text as 
well as numbers. For 
example, you could 
define a constant for 
your company name or 
address. 

Named Constants
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Formula Assistance
Excel provides assistance as you enter formulas, to make them 
easier to construct and to help you check that you have chosen the 
required values and operations. 

l1 When you type a defined name, Excel outlines the 
associated cell or range of cells 

Here we calculate a 
numeric progression and 
the total and average of 
its terms. F, D and N are 
defined names. 

Coloring matching 
pairs of parentheses 
makes it easier to check 
the calculation and 
spot errors such as 
superfluous parentheses. 

l2 With nested calculations, Excel colors matching pairs of 
parentheses to clarify the operations 

l3 If you do make a mistake, such as entering an extra 
parenthesis as shown above, Excel will detect the error 
and may offer a correction 
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Add notes to a cell – for example, to explain how a particular 
formula operates. To add such a comment:

l1 Select the cell where the comment is meant to display

When you have created 
a comment, the New 
Comment button is 
replaced by the Edit 
Comment button. 
There’s also a Delete 
button, Previous and 
Next to view other 
comments, Show/Hide 
Comment and Show 
All Comments.

Adding Comments

l2 Click the Review tab and select New Comment from the 
Comments group

l3 Your username is shown. Delete this if desired, then add 
your comments, and format the text if you wish 

l4 Select any other cell to save and close the comment

l5 The red flash indicates the presence of a comment, which 
is displayed when you move the mouse over that cell 

When you have 
comments in your 
worksheet, you can print 
them as displayed, or 
print all comments at the 
end of the sheet. 
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Error Values

If the formula has a 
reference to C1 and 
you copy the formula 
upwards, the relative 
reference changes to C0, 
which is an invalid cell 
reference. 

When the error value 
shows a green flash, 
select the cell and click 
the Information icon for 
more details and options 
for handling the error. 

If Excel detects a problem for which it is unable to offer a 
correction, it will place an error value in the cell. Here are some of 
the error values you may encounter: 

l1 When a number is too long to fit into a cell, the 
Overflow error is shown. Resolve by widening the cell or 
choosing a smaller number format 

l2 When the formula contains division by a value of zero or 
by an empty cell, you get a Divide by Zero error 

l3 A NAME error implies reference to a deleted name, or to 
a name that has not been defined 

l4 A NULL error results from referencing the intersection 
or two ranges that do not overlap 

l5 You’ll get a NUM error with invalid arguments, such as 
a negative number with the square root function, or a 
VALUE error with an argument of the wrong data type 

l6 An invalid reference gives a REF error, such as when you 
copy a formula and get an invalid cell reference 


	TOC_web
	01_web

